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CA 210 Operating System-I

Configuring and Managing File Systems

A file system is the structure in which files are named, stored, and accessed. Microsoft® Windows® XP Professional supports three types of file systems on hard disks: 

· FAT (file allocation table) 

· FAT32 

· NTFS file system 

It is important that you understand how file systems work so that you can select the file system or file systems that are best suited for your environment and tasks. You should also know how to manage files and folders and secure confidential and private files. 

After completing this module, you will be able to:
· Describe the differences between the various files systems that are supported by Windows XP Professional.

· Compress data on an NTFS volume and manage compressed files.

· Encrypt and decrypt data on an NTFS volume. 

Working with File Systems

When choosing a FAT, FAT32, or NTFS file system, you must consider the features and functions that are associated with that file system. You must also consider limitations, such as maximum volume size, cluster size, file size, and compatibility with other operating systems

Note: The term volume is used in this module to refer to both basic volumes (that is, partitions on a basic disk) and dynamic volumes.

For Windows XP Professional, NTFS is the preferred file system. NTFS supports valuable functionality such as file compression, a higher level of security, and formatting of very large volume sizes for compatibility with the latest disk technology. 

You can easily convert volumes from FAT or FAT32 to NTFS when upgrading to Windows XP Professional. All data on existing FAT or FAT32 volumes is written to new NTFS volumes.

Important: After you have converted a volume to NTFS, you cannot convert back to FAT or FAT32 without reformatting the volume

In this lesson you will learn about the following topics: 

· Using FAT or FAT32 

· Using NTFS 

· Selecting a file system 

· Converting file systems

Using FAT or FAT32

FAT is the file system that is used by Microsoft MS-DOS® and subsequent versions of Windows. FAT32 was introduced with Microsoft Windows 95 OSR2. Windows XP Professional supports both FAT and FAT32. 

The major differences between FAT and FAT32 are:

· Volume size. 

· Cluster size. 

· Supported operating systems. 

FAT works best on small disks with simple folder structures. FAT32 works well on larger disks with more complex folder structures. The following table compares FAT and FAT32
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Supports volume sizes up to 2 gigabytes (GB).
	
	
Supports volume sizes up to 32 GB. Volume can be as large as 2 terabytes, but Windows XP Professional limits the volume that you can format to 32 GB.
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You must divide a large disk into volumes where no volume exceeds 2 GB.
	
	
Greater flexibility on how you organize large disks: from many small volumes up to a single large volume, not exceeding 32 GB.
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Supports cluster sizes up to 64 KB for large volumes.
	
	
Supports smaller cluster sizes not exceeding 16 KB. Small cluster sizes are preferable because they reduce wasted space on hard disks.
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Supports dual-boot configurations.
	
	
Supports dual-boot configurations on operating systems that support FAT32.
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Note: Windows XP Professional can read and write to larger FAT32 volumes formatted by Microsoft Windows 98 and Microsoft Windows 2000.
Using FAT or FAT32

Operating systems can access only the volumes that are formatted with a file system that the operating system supports. The following table shows the files systems that are supported on various Windows operating systems.
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	Supports NTFS
	
	Supports FAT32
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 Supports FAT
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Windows XP Professional
	
	
Yes
	
	
Yes
	
	
Yes
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Windows 2000 Professional
	
	
Yes
	
	
Yes
	
	
Yes
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Microsoft Windows NT Workstation 4.0
	
	
Yes
	
	
No
	
	
Yes
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Windows 95 OSR2, Windows 98, and Microsoft Windows Millennium Edition
	
	
No
	
	
Yes
	
	
Yes
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Windows 95 (prior to version OSR2)
	
	
No
	
	
No
	
	
Yes
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MS-DOS
	
	
No
	
	
No
	
	
Yes
	
	


If you need a dual-boot system, you must consider the operating systems that you are running when selecting a file system. Using Windows XP Professional with certain dual-boot configurations may require you to use FAT or FAT32.

Note: Windows NT Workstation 4.0 with Service Pack 3 or earlier supports a version of NTFS that is not compatible with NTFS running on Windows XP Professional. If you require a dual-boot system with these two operating systems, you would need to use FAT or FAT32 for Windows NT

Using NTFS

NTFS is a file system that is available on Windows NT, Windows 2000, and Windows XP Professional. It is not available on other versions of Windows operating systems. NTFS provides performance and features that are not found in either FAT or FAT32. NTFS provides:

· Reliability

NTFS uses log file and checkpoint information to restore the consistency of the file system when the computer is restarted. In the event of a bad-sector error, NTFS dynamically remaps the cluster containing the bad sector and allocates a new cluster for the data. NTFS also marks the cluster as bad and no longer uses it.
· Greater security:

NTFS files use Encrypting File System (EFS) to secure files and folders. If enabled, files and folders can be encrypted for use by single or multiple users. The benefits of encryption are data confidentiality and data integrity, which can protect data against malicious or accidental modification. NTFS also enables you to set access permissions on a file or folder. Permissions can be set to Read Only, Read and Write, or No Access.
· Improved management:

NTFS supports the use of disk quotas. Disk quotas enable you to specify the amount of disk space that is available to a user. By enabling disk quotas, you can track and control disk space usage. You can configure whether users are allowed to exceed their limits, and you can also configure Windows XP Professional to log an event when a user exceeds a specified warning level or quota limit. 

With NTFS you can easily create extra disk space by compressing files, extending volumes, or mounting a drive. File compression is also discussed in this module.
of storage growth 

· Support for larger volume sizes :
Theoretically, you can format a volume up to 32 exabytes by using NTFS. NTFS also supports larger files and a larger number of files per volume than FAT or FAT32. NTFS also manages disk space efficiently by using smaller cluster sizes. For example, a 30-GB NTFS volume uses 4-KB clusters. The same volume formatted with FAT32 uses 16-KB clusters. Using smaller clusters reduces wasted space on hard disks.
Selecting a File System

You can use any combination of FAT, FAT32, or NTFS when formatting a hard disk. However, each volume on a hard disk can only be formatted with a single file system. 

When choosing the appropriate file system to use, you need to determine: 

· If the computer has a single operating system or is a multiple-boot system.

On computers that contain multiple operating systems, file system compatibility can be complex because different versions of Windows support different combinations of file systems.
· The number and size of locally installed hard disks. 

Each file system has a different maximum volume size. As volume sizes increase, your choice of file systems becomes limited. For example, both FAT32 and NTFS can read volumes larger than 32 GB; however only NTFS can be used for format volumes larger than 32 GB in Windows XP Professional.
· Security considerations. 

NTFS offers security features, such as encryption and file and folder permissions. These features are not available on FAT or FAT32 volumes.
· If you benefit by using advanced file system features. 

NTFS offers features such as disk quotas, distributed link tracking, compression, and mounted drives. These features are not available on FAT or FAT32 volumes. 
Converting File Systems
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Converting File Systems
Converting a volume's file system is different from formatting a volume. You format a volume that has no previous file system format. You convert a volume's file system when changing the existing file format to a new file format. Windows XP Professional can convert FAT, FAT32, and NTFS in Windows NT to the version of NTFS in Windows XP Professional.


Converting File Systems
Using NTFS with Windows 2000 and Windows XP Professional

Windows 2000 and Windows XP Professional use the same version of NTFS. Therefore, no conversion occurs when Windows XP Professional first accesses an NTFS volume that was formatted by using Windows 2000. 

Using NTFS with Windows NT 4.0 and Windows XP Professional 

When you upgrade from Windows NT 4.0 to Windows XP Professional, all NTFS volumes that were formatted by using Windows NT 4.0 are upgraded to the new version of NTFS. The upgrade occurs when Windows XP Professional accesses the volume for the first time after Windows XP Professional Setup is completed. Any NTFS volumes that are removed or turned off during Setup, or added after Setup, are converted when Windows XP Professional accesses the volumes

Converting FAT or FAT32 Volumes to NTFS 

You can convert a FAT or FAT32 volume to NTFS by using the Setup program when upgrading to Windows XP Professional. If you choose to convert after you have installed Windows XP Professional, you can use Disk Management or the convert command from a command prompt. 

To use the convert command to convert a volume to NTFS, open the command prompt window, and then type: 

convert drive letter: /FS:NTFS 

Before you convert a FAT or FAT32 volume to NTFS, you must consider the following: 

· Despite a minimal chance of corruption or data loss during the conversion from FAT to NTFS, it is recommended that you perform a full backup of the data on the volume to be converted before you convert to NTFS. It is also recommended that you verify the integrity of the backup before proceeding. 

· The conversion is a one-way process. After you convert a volume to NTFS, you cannot reconvert the volume to FAT without backing up data on the NTFS volume, reformatting the volume as FAT, and then restoring the data onto the newly formatted FAT volume. 

· Converting the file system requires a certain amount of free space on the volume and sufficient memory to update the cache. Ensure that you have sufficient available disk space. 
You cannot convert the Windows XP Professional boot volume while Windows XP Professional is running, nor can you force a dismount of the volume that contains a paging file. A paging file is a temporary file space that is used for virtual memory. In these situations, you must schedule the conversion to occur the next time that you start Windows XP Professional. 


Managing Data Compression
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	Compressed files and folders occupy less space on an NTFS-formatted volume, thus enabling you to store more data. You can designate the compression state of files and folders as either compressed or uncompressed. 

Also, files and folders that you copy or move can retain their compression states, or they can assume the compression state of the target folder to which they are copied or moved. There are best practices for managing data compression that you should follow.



Note: Data compression affects performance by slowing the processes of accessing and storing data. Therefore, compress data only when storage alternatives are unavailable.

In this lesson you will learn about the following topics:

· Defining compresses files and folders 

· Compressing files and folders 

· Copying and moving compressed files and folders 

· Best practices for managing data compression 

Defining Compressed Files and Folders

	Each file and folder on an NTFS volume has a compression state, which is either compressed or uncompressed. The compression state for a folder does not necessarily reflect the compression state of the files and subfolders in that folder. A folder can be compressed, yet all of the files in that folder can be uncompressed. Similarly, an uncompressed folder can contain compressed files. To change the compression state for a file for folder, you must have Write permissions for that file or folder. 

You can compress unencrypted files and folders that are stored on NTFS volumes. You cannot compress encrypted files or folders. 

Access to Compressed Files 

When you request access to a compressed file by using a program such as Microsoft Word, or an operating system command such as copy, Windows XP Professional automatically uncompresses the file. When you close or save the file, Windows XP Professional compresses it again. 


	1. In Windows Explorer, on the Tools menu, click Folder Options. 

2. On the View tab, select the Show encrypted or compressed NTFS files in color check box, and then click OK



In Windows XP Professional, you can use Windows Explorer, to set the compression state of files and folders. 

To compress a file or folder:

1. Right-click a file or folder, and then click Properties. 

2. In the Properties sheet for the file or folder, click Advanced. 

3. In the Advanced Attributes dialog box, select the Compress contents to save disk space check box.
If you compress a folder, the Confirm Attribute Changes dialog box appears. This dialog box has two additional options described in the following table. 


When copying a file or folder within a volume, the file or folder inherits the compressed or uncompressed state of the target folder. When moving a file or folder within a volume, the file or folder retains the original compression state regardless of the state of the target folder. When moving or copying between volumes, the file or folder inherits the state of the destination folder. The following table lists the possible copy and move options and describes how Windows XP Professional treats the compression state of a file or folder.

Securing Data by Using EFS

· Security features such as logon authentication protect network resources from unauthorized access. However, if an intruder has physical access to a computer (for example, a stolen notebook computer), that intruder can easily install a new operating system and bypass the existing operating system's security. Thus, sensitive data is left exposed. You can add an effective layer of security by encrypting these files with Encrypting File System (EFS). When the files are encrypted, the data is protected even if an intruder has full access to the computer's data storage. 

EFS provides file-level encryption for NTFS files. When a file's encryption attribute is on, EFS stores the file as encrypted. When an authorized user opens an encrypted file in an application, EFS decrypts the file in the background and provides an unencrypted copy to the application. From the user's point of view, encrypting a file is simply a matter of setting a file attribute. The authorized users can view or modify the file, and EFS saves any changes transparently as encrypted data. The unauthorized user receives the message Access Denied when attempting to access an encrypted file. 

EFS is especially useful for securing sensitive data on portable computers or on computers that are shared by several users. In a shared system, an intruder can gain access by starting up a different operating system such as MS-DOS from a floppy disk. Also, if a portable computer is stolen, the hard disk drive can be removed and plugged into another computer, and the files can be read. EFS files, however, will display unintelligible characters if a user does not have the decryption key. 
EFS enables users to store data on the hard disk in an encrypted format. After a user encrypts a file, the file remains encrypted for as long as it is stored on disk. Note that encryption and compression are different processes. Files cannot be encrypted and compressed at the same time. 

EFS has several key features: 

· It operates in the background and is transparent to users and applications.
· It enables only authorized users to gain access to an encrypted file. EFS automatically decrypts the file for use and then encrypts the file again when it is saved.
· Authorized data recovery agents can recover data that was encrypted by another user. A data recovery agent is a user account that is configured for the recovery of encrypted files. Data recovery agents ensure that data is accessible if the user that encrypted the data is unavailable or loses his or her private key. However, in Windows XP Professional, data recovery agents are not required for EFS to operate.
· Files can be encrypted locally or across the network. Files in offline folders can be encrypted.
· A display color can be used to designate encrypted files and folders.
Because EFS operates at the system level, it can save temporary files to non-EFS protected folders. For greater protection, consider encrypting at a folder level. All files that are added to EFS protected folders are encrypted automatically. EFS does not encrypt data as it is transmitted over the network. Because data is transmitted as plaintext, EFS should not be implemented as the basis of network security for files. To secure data as it is transmitted, consider: 
· Implementing EFS broadly on local computers and then using Internet Protocol security (IPSec) to encrypt data as it travels over the network.
· Using Web Distributed Authoring and Versioning (WebDAV), which encrypts files as they are transmitted. When files are retrieved from WebDAV folders, the files are transmitted as raw data streams. This means that the file is not decrypted before it is transmitted.
· Accessing encrypted files by using Remote Desktop or Terminal Services. 
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	Encrypting a Folder or File

EFS encrypts a file or folder as follows: 

1. All data streams in the file are copied to a plaintext temporary file in the system's temporary directory. 

2. A file encryption key is randomly generated and used to encrypt the data by using an encryption algorithm.

3. A Data Decryption Field (DDF) is created to contain the file encryption key and the user's public key. EFS automatically obtains the user's public key from the user's file encryption certificate. A certificate is a digital document commonly used for authentication, and is signed and issued by a certification authority. Each user has a personal certificate store created when a user is added to the system. The certification authority can issue additional certificates. 

4. If a recovery agent has been designated through Group Policy, a Data Recovery Field (DRF) is created to contain the file encryption key and the recovery agent's public key. EFS automatically obtains the recovery agent's public key from the recovery agent's file recovery certificate, which is stored in the Encrypted Data Recovery Policy. If there are multiple recovery agents, the file encryption key is encrypted with each agent's public key, and a DRF is created to store each file encryption key. 

5. EFS writes the encrypted data, along with the DDF and the DRF, back to the file. 




To encrypt a file or folder: 
1. Right-click the file or folder, and then click Properties. 

2. Click the General tab, and then click Advanced. 

3. Click Encrypt contents to secure data.

When you click OK, if the folder contains unencrypted files or subfolders, a Confirm Attribute Changes dialog box appears and gives you the option to apply the changes to the folder only, or to the folder, its subfolders, and all files. 

Encrypting Files That You Do Not Own 

EFS enables you to encrypt files that you do not own, provided that you have Write Attributes, Create Files/Write Data, and List Folder/Read Data permissions for the files. 

If you select Encrypt contents to secure data and the Confirm Attribute Changes dialog box appears, and you choose the Apply changes to this folder, subfolders and files option, only you will be able to decrypt the files; other users will not be able to gain access to the files and folders. 

If there are files encrypted that you need to have decrypted, you can recover the files by selecting the individual folders to decrypt and clearing the Encrypt contents to secure data check box.
Viewing the Encryption Status of a File or Folder

Because encryption is an attribute of a file or folder, it is possible to determine whether a file or folder is already encrypted by examining its attributes. You can also add the Attributes column to the Details view. Therefore, you will see that any file or folder with an E attribute is encrypted.

You can also indicate encrypted folders by using an alternate display color. To set an alternate display color for encrypted folders:
1. In Windows Explorer, on the Tools menu, click Folder Options. 

2. On the View tab, select the Show encrypted or compressed NTFS files in color check box, and then click OK.

Adding Authorized Users
When adding an authorized user to an EFS encrypted file, you can add a domain user or a trusted domain user. However, before a user can be added, that user must have a valid EFS certificate located on the computer or obtained from a valid service, such as the Active Directory™ directory service. 

After you encrypt a file, open the property sheet of the file, click Advanced, and then click Details to add additional authorized users. The Encryption Details property sheet displays authorized users in the upper pane and designated data recovery agents in the lower pane. Only authorized users can be added on this sheet. 
Securing Data by Using EFS

Adding Authorized Users
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To remove encryption from a file or folder: 
1. Right-click the file or folder, and then click Properties. 

2. Click the General tab, and then click Advanced. 

3. Clear the Encrypt contents to secure data check box.
Configuring the Desktop Environment

As an Information Technology (IT) support professional, you will help users configure and customize their desktops. Users' desktops, contained in their profiles, are a configurable and customizable space that can increase user productivity by making frequently used items easily available. You can also implement and enforce desktop customization policies by using profiles, which can enable users to gain access to their own desktops from any computer that is on the network.

Some of the advantages of configuring the desktop environment in Microsoft® Windows® XP Professional include providing users and organizations that use more than one language the ability to configure desktops for multiple languages and multiple locations. You can also customize the Start menu and taskbar to display most commonly used programs and network connections. In addition, Accessibility options, such as Magnifier and On-Screen Keyboard, enable all users to more easily use their computers.

The Windows XP Professional desktop is the on-screen work area on which windows, icons, menus, and dialog boxes appear. When you configure user desktop settings, you change the appearance of the work area and the items that it contains. Some of the more commonly changed user desktop settings are: 

· Display Properties 

· Desktop Shortcuts 

· Accessibility Options 

· Regional Settings 

Display properties are used to configure the visual aspects of the desktop, including the background, icons, and fonts. To gain access to the Display Properties sheet, right-click the desktop, and then click Properties.

Choosing a Theme 

Themes are a predefined set of icons, fonts, colors, sounds, desktop backgrounds, and other window elements that give your desktop a unified and distinctive look. You can choose from existing themes, create your own theme by modifying an existing theme and then saving it with a new name, or restore the look used in previous versions of Windows by using theindows Classic theme.

Configuring the Desktop Display New (modified) themes are saved in the My Documents folder. An organization may create a theme to distribute to all employees. However, unless the users are prevented from changing the theme by using Group Policy or mandatory profiles, they will be able to select alternate themes, or modify the organization's theme. 

To choose a theme, select it from the drop-down list on the Themes tab, click Apply, and then click OK.

Customizing the Desktop

Customizing the desktop entails choosing a background, and determining which shortcut icons will appear on the desktop. 

The background, known as wallpaper in previous versions of Windows, is the image or color that you see when a portion of the desktop is showing. To choose a background, click the Desktop tab on the Display Properties sheet. Background images can be stretched to fill the desktop, tiled over the entire desktop, or centered on the desktop. You can use any image as a background. Saving an image in the My Pictures folder automatically makes it available as a background. 

You can customize the desktop to include shortcuts, and change the icons that are associated with those shortcuts. To customize the desktop, on the Desktop tab, click Customize Desktop. The Desktop Items property sheet displays, which has a General tab and a Web tab.

On the General tab, you can choose which of the following icons to display on the desktop: My Computer, My Network Places, My Documents, and the Recycle Bin. Only the Recycle Bin icon displays on the desktop by default, unlike previous versions of Windows in which all of these icons displayed on the desktop by default. On the General tab, you can also select the style of the icons to represent the shortcuts, and perform or schedule a desktop cleanup. 

Desktop Cleanup moves all unused icons into a folder named Unused Icons, which is then automatically displayed on the desktop.

On the Web tab, you can choose to display content from Web pages, or other items collectively known as Desktop Items, on the desktop. Displaying links to Web content, or an organization's home page on the desktop can enable users to quickly gain access to Web-based content that is essential to their job roles.

Configuring a Screen Saver

On the Screen Saver tab, you can select a screen saver, configure the number of minutes without user interaction before the screen saver starts, and select whether the screen saver should be password protected, which requires the logged on user to enter a password to gain access to the contents of the computer. For security purposes, it is recommended that you apply password protection to screen savers. The Screen Saver tab also enables you to configure power management options.

Configuring Advanced Appearance Options
In addition to enabling you to configure the desktop background, Display Properties also control the appearance and behavior of windows, buttons, and controls that appear on the desktop. To gain access to Display Properties, right-click the desktop, and then click Properties.

Configuring Advanced Appearance Options

Configuring Appearance Options 

On the Appearance tab, you can choose the style of windows, buttons, color schemes, font sizes, visual effects, and advanced appearance options. 

The Effects button brings up a property sheet that enables you to configure the visual effects used by menus and windows. For example, you can configure transition effects for windows, configure whether a shadow appears around windows, and whether you can see the contents of a window while dragging it. Note that enabling these options uses more memory.

The Advanced button brings up the Advanced Appearance property sheet that enables you to configure the color of windows, the desktop, and other items, such as borders and title bars. Configuring options on this page will override the selection for windows and buttons on the Appearance tab. 

Configuring Settings 

The Settings tab enables you to configure screen resolution and color quality. The higher the screen resolution, the smaller the size of the normal icons that appear on the screen. Windows XP Professional requires a minimum screen resolution of 800 x 600 pixels. It does not support 480 x 640 pixels, or any other resolution lower than 800 x 600 pixels.

Clicking the Advanced button on the Settings tab enables you to configure additional monitor display properties on the (Multiple Monitors) and video adapter property sheet (where video adapter is the name of your computer's video adapter).

Configuring Desktop Shortcuts
Desktop shortcuts appear as icons on the desktop. Shortcuts can help users make their desktops a central point from which they can quickly gain access to often used and most important items, such as a program, online or offline folder, document, or Web site. Users can choose the icons that represent those shortcuts

Adding a Program Shortcut 

A desktop shortcut to a program enables the user to open the program by double-clicking the shortcut, rather than using the Start menu. This is especially helpful when the program is used frequently, or when it is several layers deep in the menu. For example, to gain access to the Backup utility, you must click Start, click All Programs, click Accessories, click System Tools, and then click Backup. If this utility were used often, a desktop shortcut would be more convenient.

To add a program shortcut, move to the user's Programs folder, right-click the desired program icon, click Copy, right-click the desktop, and then click Paste Shortcut. You can also use the drag-and-drop feature to create a program icon on the desktop

Adding a Web Site Shortcut 

In many organizations, an intranet or Internet Web site contains information that is essential to the work of the organization's employees or members. A Web site shortcut enables the user to gain access to the Web site directly from the desktop by using the computer's default Web browser.

To add a Web site shortcut, open Microsoft Internet Explorer, go to the desired Web site, right-click anywhere on the page, click Create Shortcut, and then click OK.

Configuring Shortcuts 

You can change the icon that represents a shortcut, configure the shortcut to work with different user credentials, arrange the shortcuts on the desktop, and hide all or specific desktop icons.

Changing Icons 

To change the icon that represents a shortcut, right-click the shortcut, click Properties, click Change Icon, and then select an icon. You can choose from the hundreds of icons in Windows XP Professional, or click Browse to locate another icon image

Customizing the Desktop Environment

[image: image57.jpg]Registry Editor
Tle it Ve Favortss teb
=81y Computer e Ty osts
PO s i
ISR B Reese  (erot )
SHAEHSANR St R Dwom Siadoonns
Umoniare | Eloerat  REG_DWORD 0.0000000
Som B REGDWORD D.on0000

SEECRTY | ElListknowns. REGDWORD 00000000
2 S Tware

SET
=2 s
et

S
3 tordyar Pointers to Control Sets
23 Comraltet i the Seect Key
bi=Fortiec
< il
i

sk
2 HE? TisEhs
5 HKEY_CURRENT .|| €

iy Computar \WKEY_LOCAL WACHIE\SYSTEM Ssiact




Clicking Start displays a menu that enables users to easily gain access to the most used items on the computer. The following sections describe the organization of the Start menu and provide instruction about how to customize it.

Examining the Windows XP Professional Start Menu 

The right frame of the Start menu consists of three sections that display standard folders and utilities. The left frame also consists of three sections. The top section displays the pinned programs, which are programs that are manually attached to the top left of the Start menu. The default e-mail program and browser always appear in pinned programs. Beneath the pinned programs, recently used programs appear.

The. The light blue area can only be customized in limited ways. When customizing the different sections of the Start menu, you have the choice of customizing it for the user who is currently logged on, or for all users on the computer.

Customizing the Start Menu for All Users

When you customize the Start menu for all users, you are adding an item that anyone logged on to the computer can use.

You can add a submenu to the Start menu for easy access to a group of programs. For example, if everyone who uses a computer performs the same job function, you might want to add a submenu that contains the programs that the employees use most. You can also add to the Start menu a shortcut to a specific program or resource, or drag a frequently used item in a submenu onto the main Start menu.

Adding a Submenu for All Users 

To add a submenu for all users, perform the following steps:
1. Right-click Start, and then click Open all Users.

2. Double-click the folder to which you want to add the submenu.

If you place the submenu in the Start Menu folder, it becomes pinned to the top of the All Programs menu. If you place the submenu in the Programs folder, it will be placed alphabetically in the list of programs.

3. On the File menu, point to New, and then click Folder.

Adding a Shortcut for All Users

To add a shortcut for all users, perform the following steps:
1. Right-click Start, click Open All Users, click File, point to New, and then click Shortcut.

2. Type the location of the item for which you want to create a shortcut, or click Browse to locate the item, and then click OK.

3. Click Next, type a name for the shortcut, and then click Finish. 

Customizing the Start Menu for Individual Users

There may be instances when you will want to customize the Start menu for a particular user only. You can add shortcuts and submenus, and pin programs to an individual's Start menu.

Adding a Submenu for an Individual User

The process for adding a submenu to an individual's Start menu is similar to adding a submenu for all users. The difference between the two procedures is the first step of the process, which changes as follows:

· Right-click Start, click Explore All Users, expand the folder of the user whose Start menu that you want to customize, and then click Start Menu. 

Adding a Shortcut for an Individual User

To add a shortcut to an individual's Start menu, perform the following steps:

1. Right-click the object for which you want to create a shortcut, and then click Create Shortcut.

2. Drag, or cut and paste, the shortcut into the individual's Start menu or Programs folder. 

Changing Start Menu Properties

You can alter the properties of the Start menu; for example, you can change whether items are displayed as links or menus or not displayed at all. When you make this type of alteration, the change affects only the logged on user.

To make changes to Start menu properties, perform these steps: 

· Right-click Start, click Properties, click Customize, make desired changes on the General and Advanced tabs, and then click OK twice

Pinning a Program to the Start Menu

Programs are the only items that you can pin to the Start menu. When you pin a program to the Start menu, it applies only to the user that is currently logged on. To accomplish this task:

· Right-click the program that you want to pin to the Start menu, and then click Pin to Start menu. 

Customizing the Startup Folder

If users always use a particular program or programs as soon as they log on, it is convenient to have those programs automatically start when the user logs on. To enable a program to start automatically when a user logs on, place a shortcut to that program in the appropriate Startup folder. You can customize the Startup folder for all users or individual users.

To enable programs to start automatically upon logon, perform the following steps:

1. Right-click Start, and then click Explore All Users.

2. Expand either All Users or a specific user. 

3. Expand Start Menu, and then click Programs in the left pane. 

4. In the right pane, copy the shortcut for the programs that you want to start automatically upon logon.

5. Expand Programs, right-click Startup, and then click Paste. 

The shortcuts to the desired programs will now appear in the Startup folder. When the user whose Startup folder you have customized next logs on, the programs will automatically start

Customizing the Taskbar

Adding Programs to the Quick Launch Toolbar

To add frequently used icons to the Quick Launch toolbar for easy, one-click access, perform the following steps:

1. Right-click an empty area of the Quick Launch bar, and then click 
Open Folder.

2. On the File menu, click New, and then click Shortcut.

3. Type the location of, or browse to, the desired program, click Next, and then click Finish. 

Alternately, you can drag any program icon onto the Quick Launch toolbar, which will automatically create a shortcut to the program
Configuring TCP/IP Addressing and Names Resolution

Transmission Control Protocol/Internet Protocol (TCP/IP) for Microsoft® Windows® XP Professional offers a standard, routable, enterprise networking protocol that is the most complete and accepted protocol available. Most current network operating systems offer TCP/IP support, and large networks rely on TCP/IP for much of their network traffic. 

TCP/IP identifies source and destination computers by their IP addresses. To communicate on a network, each computer must have a unique IP address and conform to a standard format. Understanding IP address configuration options and basic IP address troubleshooting is necessary to successfully connect to the network.

A device name is generally a user-friendly name that uniquely identifies a device on the network. An example of a user-friendly name is the name that you provide when you install Windows XP Professional. 

For applications that use names instead of IP addresses, Windows XP Professional has several possible methods to map these names to IP addresses. Without the ability to map names to IP addresses, applications that use names would not be able to communicate in a TCP/IP environment.
Configuring IP Addresses

Windows XP Professional provides two methods for assigning IP addresses to devices on TCP/IP networks:

· Dynamic addressing by using Dynamic Host Configuration Protocol (DHCP) to assign an IP address.

· Static or manual addressing by physically entering the IP address at the client computer. 

Configuring IP Addresses

Selecting the method of IP address assignment depends on your environment and client requirements. If a DHCP server is not available and communication with hosts outside of a single subnet is required, you must use static addressing. A subnet is a segment of a network that shares a network address with other portions of the network but is distinguished by a subnet number.

Your network administrator must determine whether static or dynamic addressing will be used. If static addressing is used, the administrator must also determine the IP addresses that will be assigned to the network devices. However, DHCP is the preferred method for assigning IP addresses.

Windows XP Professional provides a new feature for clients that use DHCP. If a client computer is configured to obtain an IP address automatically, you can specify alternate IP settings for the same client. Whenever the DHCP server is unavailable, the alternate IP configuration will be used to connect to the network. This feature enables portable computers to easily switch between an environment in which DHCP is available, such as your office, and one that does not provide DHCP, such as an Internet service provider (ISP). 

After you set the IP address, you can view its TCP/IP configuration by using either the Internet Protocol (TCP/IP) Properties sheet or the ipconfig command

Assigning Static IP Addresses
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Static IP addressing refers to configuring IP addresses manually. In this method, you assign an IP address to the host or network device. Windows XP Professional provides the Internet Protocol (TCP/IP) Properties sheet to manually assign an IP address
In addition to specifying the IP address, you must specify a subnet mask and a default gateway address, if necessary. These numbers provide added identification for the host or device. A subnet mask is used to identify whether a destination address is on the local subnet or a remote subnet. If the destination address is on a remote subnet, the local computer will use the address of the default gateway for forwarding the information outside of the local subnet. If a destination address is on the local subnet, the information is forwarded to the specified device without going through the gateway. Therefore, a default gateway address is not needed if you only have a single subnet on your network and with no requirements to communicate outside that local subnet.
To manually configure the IP address:

1. On the Start menu, click Control Panel, click Network and Internet Connections, and then click Network Connections.

2. Right-click Local Area Connection, and then click Properties.

3. In the Local Area Connection Properties sheet, click Internet Protocol (TCP/IP), and then click Properties. 

4. In the Internet Protocol (TCP/IP) Properties sheet, click Use the following IP address to enter values for IP address, Subnet mask, and Default gateway, and then click OK twice. 

Overview of Dynamic Address Assignment

Dynamic addressing is the default addressing method in Windows XP Professional. In dynamic addressing, the DHCP server supplies an IP address subnet mask, and default gateway to the client.  [image: image43.jpg]



 
If DHCP is unavailable, an alternate address is provided depending on the client configurations found in the Alternate Configuration tab of the Internet Protocol (TCP/IP) Properties sheet. The following options are available for alternate configuration:

· Automatic private IP address. The computer will use a specified IP address range. 

· User configured. The computer will use the alternate static IP configuration that is specified in the Alternate Configuration tab. 

If a static address is specified, this will be the only address that Windows XP Professional uses to communicate, and alternate address methods will not be available.

 Using DHCP to Automate IP Address Assignments 

By default, Windows XP Professional is configured to obtain an IP address automatically by using Dynamic Host Configuration Protocol (DHCP).

To enable DHCP, you must click Obtain an IP address automatically. If you need to change a host from static to dynamic addressing:

1. On the Start menu, click Control Panel, click Network and Internet Connections, and then click Network Connections.

2. Right-click Local Area Connection, and then click Properties.

3. In the Local Area Connection Properties sheet, click Internet Protocol (TCP/IP), and then click Properties.

4. In the Internet Protocol (TCP/IP) Properties sheet, click Obtain an IP address automatically, and then click OK twice. 

DHCP reduces the complexity and amount of administrative work involved in reconfiguring computers in TCP/IP-based networks. Without DHCP, when you move a computer from one subnet to another, you must change its IP address, and possibly the subnet mask and default gateway, to reflect the new network and host ID. DHCP enables you to automatically assign an IP address to a host, from a database of addresses assigned to the subnet. Also, when a computer is offline for a specific amount of time, DHCP can reassign its IP address.

Enabling Alternate IP Configuration
When you select dynamic addressing on the General tab of the Internet Protocol (TCP/IP) Properties sheet, you can also specify an alternate IP address in the event that DHCP is unavailable. After you select Obtain and IP address automatically, the Alternate Configuration tab becomes available.

Enabling Alternate IP Configuration

Specifying a secondary static address is ideal for users with portable computers that use DHCP at one location but are required to use a static address at another location. This feature enables a portable computer to operate seamlessly on both networks without manual TCP/IP reconfiguration.

In the Internet Protocol (TCP/IP) Properties sheet, on the Alternate Configuration tab, the options for alternative configuration are:

· Automatic private IP address. This option assigns an address from the reserved address pool for private IP addresses. This pool of addresses ranges from 169.254.0.1 through 169.254.255.254. With this option enabled, DNS, Windows Internet Name Service (WINS), or a default gateway are not assigned because automatic private IP addressing is designed only for a small network that consists of a single subnet.

· User configured. This option assigns the static TCP/IP configuration that is specified on the Alternate Configuration tab. Settings for IP address and Subnet mask are required. All other settings (Default gateway, DNS server, and WINS server) may be necessary based on your network configuration.

Troubleshooting IP Addresses

Windows XP Professional contains several utilities that you can use to diagnose network problems. For example, you can use TCP/IP troubleshooting utilities to modify the Address Resolution Protocol (ARP) cache, verify the host name of your computer, determine whether a router or link is causing network problems, and determine whether a router is forwarding packets successfully.

In addition, you can use the ipconfig command to verify and modify TCP/IP configuration, and use the ping command to test TCP/IP configuration and connections.

Using TCP/IP Troubleshooting Utilities

Windows XP Professional provides a number of TCP/IP diagnostic utilities that assist users in detecting and resolving networking problems. Some of the common diagnostic utilities are: 

-arp  

-hostname 
-ipconfig 

-ping 

-pathping 

-tracert 

Using ipconfig to Troubleshoot IP Addressing

Windows XP Professional provides ipconfig to view TCP/IP information. The ipconfig command is used to verify the TCP/IP configuration options on a host, including the IP address, subnet mask, and default gateway. 

To start the ipconfig command, type ipconfig at the command prompt. The values of the three primary configuration parameters are displayed. You can obtain more information on the TCP/IP configuration settings, type ipconfig /all at the command prompt. The screen displays the information about all TCP/IP configuration options. By using this command, you can determine whether DHCP is enabled at the client computer. 

A DHCP server leases an IP address to a client for a specific length of time. The Lease Obtained and Lease Expires labels display information about when the lease was obtained and when it will expire, respectively.

Additional commands useful for troubleshooting an IP address are:

· ipconfig /release. Releases all connections for the computer's adapter. 

· ipconfig /renew. Renews the connections for the computer's adapter according to the Internet Protocol (TCP/IP) Properties sheet. 

These commands are useful when moving from a static address to a dynamic address with DHCP. The release command releases the static address from the adapter, and the renew command sends a request to DHCP to assign an address

Dynamic IP Mapping

An alternative to static mapping is dynamic mapping. The advantage of dynamic IP mappings is that these tables are updated automatically. To accomplish automatic update, the dynamic tables use one of two services: DNS for host names and WINS for NetBIOS names.

Domain Name System

DNS is a hierarchical client/server-based distributed database management system. The purpose of the DNS database is to translate computer names into IP addresses. When a user enters a domain name in an application, the DNS service maps the name to an IP address. If you are using the Active Directory™ directory service, you must implement DNS.

The DNS naming system maps names to corresponding numbers, and is organized in a hierarchical fashion to enable scalability to large systems. Individuals within the same city code must have a unique phone number. Individuals in other cities can have a duplicate telephone number if the city codes are unique. Individuals in different countries can use the same city code and telephone number if the country code is unique. Similarly, a host name can be duplicated if some portion of the domain name is unique.

Each computer that stores the domain name-to-IP address mapping records has mappings for only its area. These computers, known as DNS servers, only process queries for computers located in their respective areas. As the mappings in the area change, DNS servers can be updated automatically with the new information
Windows Internet Name Service

In Windows XP Professional, the primary means for client computers to locate and communicate with other computers on a TCP/IP network is by using DNS. However, clients using previous versions of Windows, such as computers running Microsoft Windows 98 or Microsoft Windows NT 4.0, also use NetBIOS names for network communication. As a result, these clients require a method of resolving NetBIOS names to IP addresses.

WINS provides a distributed database for registering dynamic mappings of NetBIOS names that are used on a network. WINS maps NetBIOS names to IP addresses and enables NetBIOS names to be used across routers

Static IP Mapping

If you implement a HOSTS file or LMHOSTS file, a copy of this file resides on each computer in the network. The advantage of using the text file is the ability to customize it. The tables in these files contain any number of required entries, including easy-to-remember aliases for frequently accessed resources. However, if the file contains a large number of IP address mappings or if the IP addresses change, the maintenance task becomes equally large. 

Some non-Windows operating systems are case sensitive (for example, UNIX). If a single, centralized table is maintained and used by various operating systems, ensure that the entries will be accepted by all hosts on the network

HOSTS File

The HOSTS file is a text file that contains IP address-to-host name mappings. The following list describes the HOSTS file:

· A single entry consists of an IP address corresponding to one or more host names.

· A HOSTS file must reside on each computer.

· The HOSTS file is used by ping and other TCP/IP utilities to resolve a host name to an IP address on both local and remote networks.

· In Windows XP Professional, the HOSTS file can also be used to resolve NetBIOS names if necessary.

· The HOSTS file can be edited with any text editor. When first viewing the HOSTS file, its content is empty. It requires an administrator to add entries. The directory location is:

%systemroot%\system32\drivers\etc\

LMHOSTS File 

The LMHOSTS file is a text file that contains the IP address-to-NetBIOS name mappings. A portion of the LMHOSTS file is pre-loaded into memory and is referred to as the NetBIOS name cache. The LMHOSTS file has the following characteristics:

· It resolves NetBIOS names used in Windows NT and other NetBIOS applications.

Determining TCP/IP Name Resolution Methods 

Selecting a Name Resolution Method
Before you can select a name resolution method, you need to determine whether your environment and client requirements must be configured with DNS only, or DNS and WINS.

DNS is required when the client computer: 

· Is a member of an Active Directory domain. 

· Needs to communicate over the Internet. 

Windows XP Professional supports NetBIOS over TCP/IP (NetBT) to provide name resolution and connection services for clients that use earlier versions of Windows operating systems, applications, and services. NetBT enables NetBIOS-based applications to communicate by using TCP/IP.

WINS is required when the client computer: 

· Is a member of a Windows NT 4.0 or earlier domain. 

· Uses applications or services that require NetBIOS name resolution. 

If a WINS server is not available and NetBIOS name resolution is needed, configure the client computer running Windows XP Professional to use an LMHOSTS file for NetBIOS name resolution.

Determining TCP/IP Name Resolution Methods

Host Name Resolution Process
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	Understanding the name resolution process is important if you are troubleshooting a communication problem on the network. Host names can be resolved directly by the HOSTS file or by a DNS server. If the name is not resolved at that point, Windows XP Professional will attempt to resolve the host name as a NetBIOS name. As soon as the name and IP address are resolved, the name resolution process discontinues.

Applications in Windows XP Professional are designed to use host names, but both NetBIOS and host names can be resolved by using either process. It is the order of resolution and the time that it takes to resolve names that differs between the methods.



Connecting to a Remote Host:
A standard Windows XP Professional installation without any additional Microsoft or third-party software, provides basic connectivity to remote hosts including hosts running other operating systems such as UNIX. This level of connectivity involves utilizing the basic Internet standard TCP/IP services and utilities within the Windows XP Professional operating system and the services configured on the network. 

In this lesson you will learn about the following topics:

· Working with FTP  ,
Telnet  
and 
 HyperTerminal 

Windows XP Professional provides access to remote hosts with the standard TCP/IP protocol suite of applications, including FTP (File Transfer Protocol) and Telnet.

· File Transfer Protocol (FTP) is an application level protocol, used for transferring files to and from remote computer systems.

· Telnet is an application-level protocol that enables a user to log on and use a remote computer as if that user were sitting directly at that computer. 

Windows XP Professional provides both client and server services for these two TCP/IP applications. 

Working with FTP
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FTP sessions require a server and a client. The server responds to requests from clients. Typically, the server is the repository of files. Clients either upload files to the server or download files from the server. Clients can also perform other file operations such as creating folders, renaming files or folders, and deleting files, depending on the permissions granted by the FTP server.

Windows XP Professional provides various client FTP interfaces along with the tools for hosting FTP sites with the use of Internet Information Services (IIS). IIS provides an FTP server along with other virtual servers to support TCP/IP applications
Windows XP Professional IIS FTP Server

To configure a computer running Windows XP Professional as an FTP server:

1. From Control Panel, click Add or Remove Programs, click Add/Remove Windows Components, click Internet Information Services (IIS), and then click Details.

2. Select the File Transfer Protocol (FTP) Service check box, click OK, and then click Next. If prompted, insert your Windows XP Professional CD. After the necessary files are copied, click Finish.

3. In the Computer Management console, under Services and Applications, under Internet Information Service, under FTP Sites, right-click Default FTP Site, and then click Properties.

4. To establish a secure server, configure the following settings: 

1. On the FTP Site tab, select the Enable Logging check box.

2. On the Security Accounts tab, select Allow Anonymous Connections and Allow Only Anonymous Connections.

3. On the Messages tab, under Welcome, type the following warning message: 

All access to this server is logged. Access to this server is allowed by permission only and unauthorized use will be prosecuted.
4. When you are finished, click OK. 
Windows XP Professional FTP clients

Windows XP Professional comes with three FTP clients. Selecting to use one client over another is based on user preference.

The first FTP client is a command-line utility, Ftp.exe, which contains the full FTP feature set. The second FTP client is integrated with Windows Explorer. Windows Explorer adds a full-featured graphical user interface for FTP, making folders and files on an FTP server look and work much like files on a local hard disk. Microsoft Internet Explorer offers a third alternative for interacting with FTP sites: a text-based view that visually resembles directory listings in Microsoft MS-DOS®, but contains hyperlinks for navigation and downloading.

Command-Line FTP

To use the command-line FTP client:

1 Click Start, click Run, in the Open box, type ftp and then click OK.  A command session window opens, and the prompt changes to ftp. 

2-

Open FTP sites, browse their contents, and download or upload files. The command-line format for using FTP is found by typing Help at the ftp prompt. 
Windows Explorer Graphical FTP Client

To use the Windows XP Professional graphical FTP client in Windows Explorer:

1. Open Windows Explorer. 

2. Type the ftp address in the Address box, for example:

ftp://sitename

The graphical FTP client is running. The FTP Welcome message is available by selecting FTP Server Welcome Message from the Help menu. The welcome message appears at the left side of the window if you enable Web view.

3. The graphical FTP client logs you on anonymously. To log on by using another account, use either of the following two methods: 

· Type the account name and password in the ftp address in the form:

ftp://username:password@sitename

· On the File menu, click Login As. This opens a dialog box for the user name and password. 

Using the Windows XP Professional graphical FTP client, you can then download, upload, and move files by dragging or using menu commands; however, you cannot move files between FTP sites.

Windows Explorer Text-Based FTP Client

Enabling the Windows XP Professional text-based FTP client will disable the graphical FTP client in Windows Explorer. This client enables only browsing and downloading. This FTP client does not provide a Login As menu command or a command line to enter commands. 

To access an FTP site by using a text-based FTP client:

1. Open Internet Explorer.

2. On the Tools menu, click Internet Options, click the Advanced tab, and under Browsing, clear the Enable folder view for FTP sites check box.

3. Type the ftp or IP address in the Address bar.


The text-based FTP client logs you on anonymously. 

4. To log on by using a user name and password, you must enter this information in the Address box in the form:

ftp://username:password@sitename 
Working with Telnet
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	Telnet is a TCP/IP protocol. Telnet server and Telnet client software are installed as part of the standard Windows XP Professional installation. The Telnet client and the Telnet server work together to enable users to communicate with other TCP/IP connected 


	


Telnet Client

The Telnet client enables you to connect to a TCP/IP server and interact with that server through a terminal window as if you were sitting in front of it. Typical uses of Telnet include e-mail, file transfer, and system administration, all of which involve remotely issuing commands to a Telnet server. When you gain access to a Telnet server by running Telnet client, you cannot use applications that interact with the desktop on the server.

Telnet Server

The Telnet server is a connection point for Telnet clients. When the Telnet server is running on a computer running Windows XP Professional, users on other workstations running Telnet client software can connect to the computer running Windows XP Professional. When a Telnet client connects to the Telnet server running Windows XP Professional, the user is asked to enter a user name and password. By default, only user name and password combinations that are valid on the local server can be used to log on to that server.

After logging on, a user is given a command prompt that can be used as if it had been opened in a command prompt window locally. By default, however, the user cannot use applications that interact with the Windows XP Professional desktop.
To control the access that Telnet users have to files on the server, use only NTFS on the system partition. Create a Telnet Users Group, add all Telnet users to that group, and then assign files and directory permission to control the access that members have to the files and directories.

The Telnet server service is not started by default. To start the Telnet service:

1. Click Start, right-click My Computer, and then click Manage. 

2. In Computer Management, expand Services and Applications, and then click Services. 

3. In the details pane, right-click Telnet, and then click Start
Using HyperTerminal

The Telnet client is provided in two forms: command-line and HyperTerminal.

Command-Line Telnet Client

The command-line version of Telnet is a Windows console program. To start the Telnet Client on Windows XP Professional:

· Click Start, click Run, and in the Open box, type:    
telnet 

This will start Telnet in its prompt mode. In the prompt mode, Telnet prompts for commands. To see the available commands, type help or type ?

After a connection is established, the console window becomes a terminal screen. The remote computer's output appears in this window, and your keystrokes are sent to the remote server. You can also change the mode of operation. To switch from terminal mode back to prompt or lo
cal mode, press CTRL+]. To switch from prompt or local mode to terminal mode, press ENTER. 
To terminate a Telnet session, do either of the following:

1. Press CTRL+] in the terminal mode, and then type quit. 

2. Close the Telnet console window.

HyperTerminal Telnet Client

HyperTerminal is a general-purpose Windows application that provides a Windows graphical user interface and features to the application invoked, in this example, Telnet. Using HyperTerminal Telnet client, the application creates and maintains the connection between a computer running Windows XP Professional and other computers using either a dial-up or network connection.

To start HyperTerminal: 

1. Click Start, click All Programs, click Accessories, click Communications, and then click HyperTerminal.

2. In the New Connection dialog box, type a telnet_server host name in the Name text box, and then click OK.

If the New Connection dialog box does not open automatically, click File, and then click New Connection.

3. In the Connect To dialog box, in the Connect using list, select TCP/IP (Winsock), and then click OK.

This action initiates the Telnet connection as a client.

4. In the Connect To dialog box, in the Host Address box, type the IP address of the remote host or the remote_host_name (where remote_host_name is the name of the host to which you want to connect), and then click OK. 

5. To close the Telnet session, type quit in the command window.

Troubleshooting the Boot Process and Other System Issues

When a computer is turned on, it performs a very complex startup process in the background, which is commonly known as the boot process. It is possible for the boot process to fail. To overcome such failures, it is essential that you understand the components of the boot process for Microsoft® Windows® XP Professional. This understanding will enable you to address problems when the computer will not start properly. 

Other problems, such as bad or missing drivers, can also cause startup problems. System restoration tools such as Driver Rollback, System Restore, and Automated System Recovery (ASR) help you to solve these problems quickly and easily.

The techniques presented in this module can help you to address a degradation in computer performance, and also help to start an unresponsive computer.

The Microsoft Windows XP Professional Boot Process:



animation
1
The Pre-Boot Sequence  


2
The Boot Sequence



A    Initial Boot Loader Phase
 

B     Operating System Selection Phase 
C    Hardware Detection Phase 


D    Configuration Selection Phase

3
Kernel Load Sequence
4
Kernel Initiation Sequence 
A Hardware Key Is Created  


B   Clone Control Set Is Created 

C Device Drivers Are Loaded and Initialized

D   Services Are Started

5
 Logon Sequence 
Controlling System Settings during the Boot Process

The registry is a database that contains information about how your computer is configured. The registry is arranged in a hierarchical structure of keys and subkeys.   To edit registry keys, you can use the Registry Editor. To gain access to the Registry Editor, click Start, click Run, and then type regedit  

Examining Control Sets 
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	During the boot process, system settings are determined by control sets. A control set is a subkey that contains system information, such as which device drivers and services to load and start, and defines the dependencies among those services and devices. Pointers to each control set determine when the control sets are used. These pointers are called configurations, and are stored in the HKEY_LOCAL_MACHINE\SYSTEM\SELECT key. For example, the LastKnownGood configuration points to the last control set that was used to successfully start the computer.

The registry contains, at a minimum, two control sets: ControlSet001 and ControlSet002. There is more than one control set so that a backup control set is always available if the default control set does not function properly


Changing Startup Behavior Using the Boot.ini File

When you install Windows XP Professional, the Boot.ini file is automatically created in the root directory of the system partition. A system partition contains the hardware-specific files necessary to start the operating system, including the Boot.ini, Ntldr, and Ntdetect.com files. The operating system resides on the boot partition. The boot partition and system partition may or may not be the same partition.  

Examining the Boot.ini File 
You should understand the function of each part of the Boot.ini file before you modify it. Understanding the components of the file and their functions will enable you to safely edit the file. 

Components of the Boot.ini File

The Boot.ini file is comprised of two sections: 

· The [boot loader] section, which contains the time-out setting and the path to the default operating system.

· The [operating systems] section, which contains paths to each operating system that is installed on the computer. 

If you perform a new installation of, or upgrade to, Windows XP Professional, and there are no other operating systems on the computer, the Boot.ini file will contain only an entry for the Windows XP Professional operating system. If you install Windows XP Professional in a dual-boot configuration, there will be an entry for each operating system. 

The Ntldr file uses the information in the Boot.ini file to display the options on the Please Select an Operating System to Start menu.

ARC Paths  
The Boot.ini file uses Advanced RISC Computing (ARC) paths to point to the partition(s) on which the operating system(s) reside. The following are examples of ARC paths:

SCSI(0)disk(1)rdisk(0)partition(1)\Windows=Microsoft Windows XP
multi(0)disk(0)rdisk(1)partition(2)\Windows=Microsoft Windows 2000
Modifying the Boot.ini File
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The safest way to modify the Boot.ini file is in Control Panel. By using Control Panel rather than editing the file directly, you are less likely to damage the file. To manually edit the Boot.ini file, you must first enable protected system files to be displayed, which makes all system files more vulnerable to corruption.
Modifying the Boot.ini File 

=>
Modifying the Time-out and Default Settings

You can modify the time-out and default values of the Boot.ini file by using System Properties in Control Panel. To modify these settings, perform the following steps:

1. Click Start, click Control Panel, click Performance and Maintenance Tools, and then click System.

2. On the Advanced tab, under Startup and Recovery, click Settings, and then perform any or all of the following tasks: 

· To change the default operating system, under System Startup choose a Default operating system from the drop-down list.

· To change the time-out duration, alter the number in the Display a list of operating systems for xx seconds box.

· To display a list of operating systems, select the check box under System Startup. This setting is enabled by default.

· To disable the display of operating systems, clear the check box under System Startup.

3. Click OK twice.
Using Advanced Boot Options to Troubleshoot Startup Problems

The advanced boot options in Windows XP Professional enable you to start the computer when you might otherwise not be able to. Safe mode is the advanced boot option that is most often used, but other options are also very useful for troubleshooting the boot process.
Using Safe Mode to Start the Computer:
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	Safe mode is a method of starting Windows XP Professional by using only default settings, which include a VGA video driver, a Microsoft mouse driver, and the minimum device drivers necessary to start the computer. When your computer will not start normally, you may be able to start it in safe mode. For example, if the computer will not start after you install new software, you may be able to start it in safe mode with minimal services running, and then change your computer settings or remove the newly installed software that is causing the problem. 


You can gain access to safe mode by pressing F8 when prompted during the startup process. The first three options on the Advanced Boot Options page are variations of safe mode. These options are:

· Safe Mode 
Starts the computer by using only the basic drivers and files needed. If the computer does not successfully start by using safe mode, you may need to use the recovery console feature to repair the system, or start the computer by using the LastKnownGood configuration.

· Safe Mode with Networking
Starts the computer by using only the basic files and drivers, plus network connections.

· Safe Mode with Command Prompt
Starts the computer by using only basic files and drivers. After logging on, the command prompt is displayed instead of the Windows XP Professional desktop, Start menu, and taskbar.

Configuring Microsoft Windows XP Professional  to Operate in Microsoft Networks
Both workgroups and domains are network environments; however, the way in which user accounts, authentication, and security are handled in each is quite different. To configure Microsoft® Windows® XP Professional to operate in a workgroup or a domain, you must correctly create and configure user accounts, and configure the security of the network. As an Information Technology (IT) professional, it is critical that you understand the similarities and differences between workgroups and domains so that you are able to configure Windows XP Professional to operate properly in your networking environment

To configure Windows XP Professional to operate in Microsoft Windows networks, you must understand how a workgroup environment affects configuration. You must also be able to differentiate the types of user accounts and their capabilities.

A workgroup is a grouping of computers on a network that share resources, such as files and printers. A workgroup is referred to as a peer-to-peer network because all of the computers in a workgroup can share resources as equals, or as peers, without a dedicated server. 

Why Workgroups Are Used

In smaller organizations, the ability for computers in a workgroup to share resources without needing to dedicate a computer as a server saves the organization the additional expense of a server and server software. Computers running server software in a workgroup are known as stand-alone servers. Workgroups are also used in organizations where centralized administration of resources and accounts is either not needed, or is undesirable.

Limitations of Workgroups

Although workgroups can be very useful, they become unwieldy if more than ten computers are on a network. In a workgroup, all user accounts are local user accounts. Each user must have a local user account on each computer to which he or she needs to gain access. Thus, if five workers have five computers in a workgroup, and they all need access to each other's resources, there would be 25 user accounts in the workgroup-one local user account for each employee on each computer. When a change is made to a user account in a workgroup, the change must be made on each individual computer in the workgroup so that the user continues to have access to all of the needed resources.

A user account contains a user's unique credentials and enables a user to log on to a domain to gain access to network resources, or to log on to a specific computer to gain access to resources on that computer. Each person who regularly uses resources on networked computers should have a user account.
Local user account
Enables a user to log on to a specific computer to gain access to resources on that computer. Users can gain access to resources on another computer on a network if they have a separate account on that other computer. These user accounts reside in computer's Security Account Manager (SAM).

Domain user account

Enables a user to log on to the domain to gain access to network resources. The user can gain access to network resources from any computer on the network by using a single user account and password. These user accounts reside in Active Directory

Built-in user account
 Enables a user to perform administrative tasks or to gain temporary access to network resources. There are two built-in user accounts, which cannot be deleted: Administrator and Guest. The local Administrator and Guest user accounts reside in the SAM and the domain Administrator and Guest user accounts reside in Active Directory. 
Built-in user accounts are automatically created during the installation of Microsoft Windows 2000 and Active Directory.

Creating and Authenticating Local User Accounts
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	Local user accounts, which are the only type of user accounts in a workgroup environment, are created on the computer on which they will be used, and enable the user to gain access to resources on that computer. 

A local user account resides in a security account database, called the Security Account Manager (SAM), of the computer on which the user account is created. Because the local user account resides locally, it controls access only to local resources, which are those resources that reside on the local computer.

When a local user account is authenticated, it is authenticated against the credentials in the local SAM.


Creating Local User Accounts
 In a workgroup environment, a local user account must be created on each computer to which the individual needs to gain access. To create a user account in a workgroup: 
1. Click Start, right-click My Computer, and then click Manage.
2. In the Computer Management console, expand Local Users and Groups, right-click Users, and then click New User.
3. In the New User dialog box, enter the User Name, the Full Name (optional), and then a Description (optional).

The default account type is "Limited", formerly known as a User account. Restricted accounts have restricted privileges. If necessary, you can change the account type in Control Panel after creating the account.
4.
Type a password, and then confirm the password.  Select either User must change password at next logon (recommended), or User cannot change password, and then select Account is Disabled unless the user will begin using the account soon.

5.
Click Create.

Default User Account Types  
When a user account is created, it has a default account type. An account type determines what actions the user is able to perform on the computer. In a workgroup, the default account type depends on how you create the user. If the user account is created through Computer Management, the default account type is Limited user. If the account is created in Control Panel, the default account type is Administrator, with no password. This account type can constitute a security risk; therefore all user accounts should be created through the Computer Management console.

Configuring Local Security  
Microsoft Management Console (MMC) enables you to gain access to administrative tools, and also to create custom consoles focused on particular tasks or computers, for example to create a console focused on local security. When you configure local security, you set policies on individual accounts and individual computers. 
To configure local security, you must either gain access to pre-configured MMC consoles, such as the Computer Management console, or create customized consoles. Pre-configured consoles, which reside in the Administrative Tools folder, cannot be customized.

The Administrative Tools folder is not visible on the default Start menu by default. To make Administrative Tools visible on the Start menu:

1. Right-click Start, and then click Properties.

2. On the Start Menu tab, ensure that Start Menu is selected, and then click Customize.

3. On the Advanced tab, under Start Menu Items, select one of the options for displaying Administrative Tools, and then click OK twice

Important security options can be configured by using a customized MMC console focused on local security. For example, Ctrl+Alt+ Del options can be configured to increase security.
Introduction to Microsoft Management Console
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One of the primary tools used to manage computers running Windows XP Professional is MMC. MMC itself does not provide management functions, but instead hosts management applications, called snap-ins, which you use to configure security on local and remote computers, administer local and remote computers, and troubleshoot computer problems
MMC provides a standardized method to create, save, and open administrative tools, which are called consoles. Consoles contain one or more snap-ins, and are saved as files with an .msc extension. All of the settings for the snap-ins contained in the console are saved and restored when the file is opened, even if the console file is opened on a different computer or network. Customized consoles can be saved to a server to be available to multiple users, or saved and used on other computers, and will work in the same way as they would on the computer on which they are created. 

Every console has a console tree displayed on the left. A console tree displays the hierarchical organization of the snap-ins that are contained within that console. This display enables you to locate a specific snap-in easily. Snap-ins that you add to the console tree appear under the console root. The console root is the top level of the console tree. The details pane, located on the right of the console, lists the contents of the active snap-in.

You configure consoles to hold snap-ins to perform specific tasks. You will use consoles to configure local security. By default, Windows XP Professional saves customized console files in the Administrative Tools folder. 

To gain access to MMC, click Start, click Run, type MMC and then click OK.

Creating a Customized Security Console
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Creating such a console enables you to open one tool to perform a variety of related tasks. To create a customized console, you add snap-ins and save the resulting console with a descriptive name.
To create a customized local security console:
1. Click Start, click Run, type mmc and then click OK.
2. On the File menu, click Add/Remove Snap-in.
3. In the Add/Remove Snap-in window, click Add.
4. In the Add Standalone Snap-in window, select Group Policy from the alphabetized list, and then click Add.
5. In the Select Group Policy Object window, verify that Local Computer is displayed, and then click Finish.

The Group Policy snap-in, which enables you to configure computer and user settings, displays as Local Computer Policy in the console tree. 
6. In the Add Standalone Snap-in window, select Local Users and Groups, and then click Add.

You can use some snap-ins to manage a remote computer. When you select this type of snap-in, a dialog box appears in which you specify the computer that the snap-in will manage. Click Local computer or Another computer, type the name of the computer, and then click Finish.
7. Close the Add Standalone Snap-in window.

8. In the Add/Remove Snap-in window, click OK.

9. On the File menu, click Save, type Local Security Console and then click Save
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The Group Policy snap-in contains Computer Configuration settings. All settings under Computer Configuration affect every user who logs on to the computer. One part of configuring computer security is configuring Account Policies on the computer. To gain access to Account Policies:
1. Open a saved console that includes the Group Policy snap-in.
2. Expand Local Computer Policy, expand Computer Configuration, expand Windows Settings, expand Security Settings, and then expand Account Policies. 

Account Policies consists of Password Policy and Account Lockout Policy. Password Policy settings enable you to configure the criteria for passwords. Account Lockout Policy settings enable you to configure the criteria for and behavior of lockouts.
Configuring Password Policy

To gain access to the configurable Password Policy settings, click Password Policy. The configurable properties appear in the right pane. Double-clicking any setting will enable you to configure it
Configuring Account Lockout Policy

To gain access to the configurable Account Lockout Policy settings, click Account Lockout Policy. The configurable properties appear in the details pane. Double-clicking any setting will enable you to configure it. To maintain a minimum level of security, set the Account Lockout Policy settings as shown in the following table

Account lockout duration

Indicates the number of minutes the account is locked out. Values from 0 to 99999 (69.4 days) are valid. A value of 0 indicates that an account is locked out until reset by an administrator.


Account lockout threshold

Indicates the number of invalid logon attempts permitted before the user account is locked out. A value of 0 indicates that the account will not be locked out, despite the number of invalid attempts.


Reset account lockout counter after
Indicates the number of minutes to wait before resetting the account lockout counter.

Configuring Local Policies
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Local Policies are also under Security Settings. To gain access to Local Policies, open a saved console that includes the Group Policy snap-in, expand Local Computer Policy, expand Computer Configuration, expand Windows Settings, expand Security Settings, and then expand Local Policies. Local Policies contain User Rights Assignment, and Security Options. User Rights Assignment settings enable you to grant permission to perform specific actions on the computer to users or groups. Security Options settings enable you to define security settings on the local computer. 
Configuring Logon Options in a Workgroup

The Welcome Screen and Fast User Switching are two logon options that are available in a workgroup environment.

Changing the Welcome Screen

The default Welcome screen provides a quick and easy method for users to log on by enabling them to select their user accounts and immediately type their passwords. This default screen displays all of the valid user accounts that have been created on the local computer. The user icons in front of each account can be replaced by an actual picture of the user, or by another image file. By default, the Administrator account is one of the accounts displayed on the Welcome screen. However, when another account is granted administrator privileges, the Administrator account will no longer appear.

You can change the Welcome screen to require users to press the CTRL+ALT+DELETE keys to display the Welcome to Windows dialog box. The user is then required to type a valid user name and password. This option displays only the user name of the last user to log on in the dialog box. To change the Welcome screen, open Control Panel, and then click User Accounts. Click Change the way users log on or off, and then clear the Use the Welcome Screen check box

Enabling Fast User Switching

The Fast User Switching option enables users to switch between user accounts without closing programs or logging off, and is enabled by default. For example, the ability to change user accounts without logging off enables users who need to perform administrative functions to gain access to the Administrator account (or another account with administrative privileges), perform the administrative function, and then return to their own accounts without needing to shut down programs or log off. 

While the Fast User Switching option enables multiple users to be simultaneously logged on and running programs, the performance of the computer will be dependent on the speed of the computer and the amount of memory available. 

When the Fast User Switching option is enabled, the user will see three options in the Log Off Windows dialog box: Log Off, Switch User, and Cancel. The Switch User button can be used to switch to another logged on user account, or to log on an additional user. When the Fast User Switching option is disabled, the Switch User button does not appear. Fast User Switching also adds an additional tab in the Windows Task Manager. On this tab, labeled Users, users can log off, and users with administrative privileges can log off themselves or other users. 

To disable Fast User Switching:
1. Click Start, click Control Panel, double-click User Accounts, and then click Change the way users log on or off.

2. Clear the Use Fast User Switching check box, and then click Apply options. 

Joining a Domain
A computer in a workgroup, or a stand-alone computer, may easily be joined to an available domain. Joining a domain enables users with domain user accounts to gain access to the resources contained on that domain. Joining a domain also makes the computer and users subject to Group Policy, Account Policies, and security settings configured for the domain. Joining a domain requires the following: 

· A domain name. 
You must have the exact name of the domain to which you want to join the computer.
· A computer account
. 
Before a computer can join a domain, it must have an account in the domain. A domain administrator can create the account by using the unique computer name, or you may create the account during installation if you have appropriate privileges. If you create the account during installation, Setup prompts you for the name and password of a user account that has the authority to add domain computer accounts.
· A DNS server, which is an available domain controller and a server running the DNS Server service.

At least one domain controller on the domain that you are joining and one DNS server must be online when you install a computer in the domain
To join a domain, perform these actions: 

1. Click Start, right-click My Computer, and then click Properties.

2. On the Computer Name tab, click Change.

3. On the Computer Name Changes page, select Domain, enter the name of the domain, and then click OK.
4. If prompted, enter the name and password of a user account that has the authority to create domain computer accounts, and then click OK.

5. When a message appears welcoming you to the domain, click OK, and then click OK in the message stating that you must restart the computer. 

6. Restart the computer for the change to take effect. 

7. After joining a domain, the user, group, and account policies configured for the domain will always supersede policies configured on the local computer.
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